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1 Introduction 
TheGreenBow VPN Client software is designed to be easily deployed and managed. It implements several 
functionnalities which enable the IT Manager to pre-configure the setup before deployment, to remotely install or 
upgrade the software, and to centrally manage VPN Configurations. 
 
This document describes the management and configuration options of TheGreenBow VPN Client. It especially 
describes a set of use cases which illustrate the way to manage the software. These use cases are describes in 
"How to" items, summarized below. 
 
Various options can be configured during the installation process of TheGreenBow VPN Client: 
 License number 
 VPN Client start mode 
 Invisible graphical user interface 
 Activation email 
 and others.. 
 
 
Additional options can be used with the software itself, for example, once the installation is completed: 
 VPN Configuration importation 
 Start/Stop the software 
 Start/Stop a VPN tunnel 
 and others.. 
 
 
You may want to deploy Installation Package via several media: 
 Network drive so that users can download and install VPN Client with a simple double click on an icon 
 CD ROM disk so that users can insert and VPN Client installation will run automatically (AutoPlay) 
 USB Stick drive so that IT managers can carry the installation package with them, insert the USB Stick into 
user laptop and installation will run automatically (AutoPlay) 

 
 
 



 

Doc.Ref Deployment Guide 

Doc.version 4.1 – May-2008 

VPN version 4.1 

 

Vpn Client Software Deployment Guide Property of TheGreenBow ©  TheGreenBow 2008 4/23 

2 VPN Client Software Deployment 
VPN Client software deployment mainly uses the capability of the setup to be run "silently", which means without 
any questions to the user during installation. 
 
To improve the transparency of the installation, the VPN Client Setup enables the use of command line options, 
which may be used to customize this installation. These command line options are fully detailed in the annexe, 
and are also described in the following various use cases. 
 

2.1 How to get the Vista setup 
Since the release 4.10, the VPN Client Setup embeds both a specific setup for Windows Vista and the classic 
setup for the other Windows version. 
Using the "/extract" option, it is possible to get from the setup only the Vista Setup, or only the XP/2000 Setup. 
 
Example: 
TheGreenBow_VPN_4_10_007.exe /extract:vista 

will extract the vista setup in a file named "TheGreenBow_VPN_4_10_007_extr.exe". 
 
Note: /extract without any option will extract the setup associated to the platform on which the setup is ran. 
 

2.2 What is a "silent" VPN Client Setup 
A "silent" VPN Setup, also know as "silent" installation, is an installation which is processed automatically without 
any questions/inputs from the user. TheGreenBow VPN Client Setup is designed to be installed silently. 
 
A silent installation uses a set of installation parameters which are stored in an installation file ("setup.iss"), and/or 
provided via command line options. 
 
The following chapters describe the way to configure the installation configuration file ("setup.iss") and the 
meaning of each available command line options. 
 

2.3 How to create a "silent" VPN Client Setup? 

� Download TheGreenBow_VPN_Client.exe setup from www.thegreenbow.com.  

 

� Unzip the executable TheGreenBow_VPN_Client.exe. 

To unzip the executable, you can use a standard zip tool like winzip. Right click on the executable and select 
"Extract to folder...". 
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The following directory and content are created: 
 

  TheGreenBow_VPN_Client 

   Disk1 

    layout.bin 

    Data1.cab 

    Data2.cab 

    Data1.hdr 

    Setup.ini 

    Setup.inx 

    Setup.exe 

    ikernel.ex_ 
 

� Generate the installation configuration file ("setup.iss") 

The installation configuration file is created through the recording of a typical installation. 
To record a typical installation, open a command window, go to the above directory, then enter the following 
command line : 
 

 
 
Note: the directory specified after the –f1 switch must be specified entirely. This switch doesn't recognize a 
relative directory. 
 
Note: Command-line options that require a parameter must be specified with no space between the option and its 
parameter. Quotation marks around an option's parameter are required only if the parameter contains spaces. 
 
Note: If no directory was specified, the "setup.iss" file is created under the Windows directory (i.e. WINDOWS or 
WINNT depending on the operating system) 
 
Important: if you plan to run software command line options (see section 6.1) at the end of the installation (e.g. 
import of a VPN Configuration file), you must not select "Reboot" when you record the silent installation. 
 

2.4 How to Deploy a VPN Client Setup from a CD-Rom? 

� Create a "silent" VPN Client Setup (see section 2.1) 

 

� Create an "autorun" file 

Create a text file called "autorun.inf". This file is used by the system, upon CD-Rom insertion, to automatically run 
TheGreenBow IPSec VPN Client software installation. 
 
The "autorun.inf" file shall have the following content: 
[autorun] 

OPEN=[cdpath\]setup.exe –s -f1"[cdpath\]setup.iss" (+ command line options) 

ICON=[cdpath\]setup.exe 
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Example: 

 
 
 

� Copy the content of the setup directory and the autorun.inf file in the root directory of the CD-Rom. 

 
Note: See section 6.1 for details about the available command line options. 
 

2.5 How to run a VPN Client Setup from a shortcut (double-clic on an icon)? 

� Create a "silent" VPN Client Setup (see section 2.1) 

 

� Right-click on the "setup.exe" file in the setup directory, and from the pop-up menu, select "Create Shortcut". 

This will create a shortcut to "setup.exe" in the setup directory. 
 

� Right-click on the new shortcut, and from the pop-up menu, select Properties. 

In the Target field, add the following options to the command line: -s -f1"[path]\setup.iss" 

where "path" is the setup directory. 
 
 
Example: 

 
 
"C:\TheGreenBow_VPN_Client\Disk1\setup.exe" –s –f1"C:\TheGreenBow_VPN_Client\Disk1\setup.iss" 
 
Important: Make sure to place space characters between each argument 
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� Move the shortcut where it can be clicked by the user (e.g. on the desktop) 

 

2.6 How to Deploy a VPN Client Setup using Batch script 

� Create a "silent" VPN Client Setup (see section 2.1) 

 

� Create a text file with a ".bat" extension (e.g. "VPN Client Setup.bat") and edit this file (right-click on the file 

and select "modify") with the command line you want to be processed. 
 
Example: 
cd .\setup 

setup.exe –s –f1"setup.iss" 

cd .. 

copy myvpnconfig.tgb C:\Program Files\TheGreenBow\TheGreenBow VPN 

cd C:\Program Files\TheGreenBow\TheGreenBow VPN 

vpnconf.exe /importonce:myvpnconfig.tgb 

(1) in this example, the setup directory is called "setup" and is located under the directory containing the batch 
file. 
(2) in this example, a VPN Configuration is imported at the end of the installation. See further sections for details 
about the import capabilities of the VPN Client Software. 
 

� Deploy this file (from a server or on an USB stick) together with the setup directory to the users. 

 

2.7 How to Deploy a VPN Client Setup from a Network Drive? 

� Create a "silent" VPN Client Setup (see section 2.1) on a network drive. 

 

� Right-click on the "setup.exe" file in the setup directory, and from the pop-up menu, select "Create Shortcut". 

This will create a shortcut to "setup.exe" in the setup directory. 
 

� Right-click on the new shortcut, and from the pop-up menu, select Properties. 

In the Target field, add the following options to the command line: -s -f1"[drive:\path]\setup.iss" 

where "drive:\path" is the setup drive and directory. 
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Example: 

 
 
"F:\TheGreenBow_VPN_Client\Disk1\setup.exe" –s –f1"F:\TheGreenBow_VPN_Client\Disk1\setup.iss" 
 
Important: Make sure to place space characters between each argument 
 

� Move the shortcut where it can be clicked by the user (e.g. on the desktop) 

 

2.8 How to deploy a VPN Client Software Update? 
A VPN Client software Update is composed of an uninstallation followed by a re-installation. This procedure 
seems to require two reboots: one after the uninstallation and one after the (re-)installation. Actually, the reboot 
after the uninstallation may be skipped. 
 
This section details how to create a "silent" Software Update, with only one reboot required. 
 

� Install TheGreenBow VPN Client. You may run a "silent" installation as described in section 2.1 

 

� Unzip the executable TheGreenBow_VPN_Client.exe. 

To unzip the executable, you can use a standard zip tool like winzip. Right click on the executable and select 
"Extract to folder...". 
 

� Generate the uninstallation configuration file ("uninstall.iss") 

The uninstallation configuration file is created through the recording of a typical uninstallation. 
To record a typical uninstallation, open a command window, go to the above directory, then enter the following 
command line: 
 
C:\TheGreenBow_Vpn_Client\Disk1\setup.exe –r –f1"C:\TheGreenBow_VPN_Client\Disk1\uninstall.iss" 
 
 
Example: 
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Follow the installation instructions until the end, all your choices are logged in the uninstall.iss file. 
To the last question "do you want to reboot", select "No". 
 

� Create the script for a silent update 

Create a text file with a ".bat" extension (e.g. "VPN_Client_Setup.bat") and edit this file (right-click on the file and 
select "modify"). The first command line will "silently" uninstall the software, the second command line will install 
the updated software. 
 
Example: 
@echo off 

cd .\setup 

setup.exe –s –f1"uninstall.iss" 

setup.exe –s –f1"setup.iss" 

@echo on 

(1) in this example, the setup directory is called "setup" and is located under the directory containing the batch 
file. 
(2) in this example, the script is also running a silent installation, which was created as described in section 2.1 
 
Note: If the VPN Client Software is not yet installed on the computer, the command "setup.exe –s –
f1"uninstall.iss" won't have any effects. 
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3 VPN Client software customized for end-users 

3.1 Introduction to VPN Client Setup customization for end-users? 
TheGreenBow VPN Client software may be used by end-users through three graphical user interfaces: 
 

1) The Configuration Panel. 

This interface (typically designed for the IT Manager) can be hidden or protected by a 
password. 

 

2) The Connection Panel . 

This interface enables to open/close tunnels and to collect simple warning messages 
on VPN connection troubles. This interface can also be hidden. 

 

3) The systray menu  

The items of the systray menu may be hidden (the tunnels are always shown). 

 

 
These modes enable the IT Manager to hide the configuration part of the software, in order to show a very simple 
interface to end-users, while preventing mis-use of the VPN configuration from end-users. 
 
Note: The VPN Configuration is signed and encrypted. Any manual editing of the file disables the VPN 
Configuration. 
 
This section describes the VPN Client setup or VPN Client software options which enable to hide or limit the 
interface of the software. 
 

3.2 How to limit VPN Client usage to Connection Panel from software menus? 
The Configuration Panel can be hidden or protected with a password. This mode can be configured from the 
software: 

� In the Configuration Panel, go to the menu "View > Configuration", enter and confirm a password. It is also 

possible to limit the number of items in the systray menu. 
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� Switch to the "Connection Panel" (Ctrl + P) 

�Optionnaly close the Connection Panel. 

 
From now on, only the Connection Panel will be displayed when the user opens the sofware (e.g. click on the 
systray icon). If the user wants to open the Configuration Panel - via Ctrl + P or via the system menu of the 
Connection Panel - he will be systematically asked for the password. 
 

3.3 How to limit VPN Client usage to Connection Panel within VPN Client Setup? 

� Create a "silent" VPN Client Setup (see section 2.1) 

� Add the option "--vpngui=user" to the setup command line. 

Example: setup.exe –s –f1"setup.iss" --vpngui=user 

 
TheGreenBow IPSec VPN Client will start showing the "Connection Panel" after the installation reboot. 
 

 
 

3.4 How to limit VPN Client usage to Connection Panel from the installation? 

� Create a "silent" VPN Client Setup (see section 2.1)  

� Add the option "--vpngui=user" to the setup command line. 

� Add the option "--password=mypassword" to the setup command line. 

 

Example: setup.exe –s –f1"setup.iss" --vpngui=user --password=admin 

 
TheGreenBow IPSec VPN Client will start showing the "Connexion Panel" after the installation reboot, and the 
user won't be able to open the Configuration Panel, which is protected by the password. 
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3.5 How to limit VPN Client usage to the systray icon from the installation? 

� Create a "silent" VPN Client Setup (see section 2.1) 

� Add the option "--vpngui=hidden" to the setup command line. 

� Add the option "--password=mypassword" to the setup command line. 

 

Example: setup.exe –s –f1"setup.iss" --vpngui=hidden --password=admin 

 
TheGreenBow IPSec VPN Client will start only showing the systray icon after the installation reboot, and the user 
won't be able to open the Configuration Panel, nor the Connection Panel, which are protected by the password. It 
will only be able to open/close VPN tunnels via the systray menu. 
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4 VPN Configuration Deployment 

4.1 How to embed a specific VPN configuration into the VPN Client Setup? 
The VPN Client Setup enables the IT Manager to embed a pre-configured VPN Configuration. This VPN 
Configuration will be automatically used by the VPN Client during the installation process. 
 
The process to create such setup is the following: 

� Create a VPN Configuration with TheGreenBow VPN Client. This step doesn't need to be done on the target 

computer and may be processed on any computer where the VPN Client software has been installed, from which 
the configuration is exported. 

� Export the VPN Configuration (menu "File > Export VPN Configuration").  

Important: The exported VPN Configuration must not be protected with a password. 

� Create a silent installation, or simply unzip the VPN Setup. 

� Add the VPN Configuration (duly configured ".tgb" file) in the unzipped setup directory. 

� Deploy the package to the user (the ".tgb" VPN Configuration is imported during the setup) 

 

4.2 How to deploy a new VPN Configuration? 

� Create a VPN Configuration with TheGreenBow VPN Client. This step doesn't need to be done on the target 

computer. 

� Export the VPN Configuration (menu "File > Export VPN Configuration").  

Important: The exported VPN configuration may be protected with a password. 
 

 

� Give the VPN Configuration to the end-user, either by email, or through file-sharing. 

� When the user opens the VPN Configuration (e.g. he opens the email attachment), he will be automatically 

asked for the password, and as the password is correctly entered, the VPN Configuration will be automatically 
imported and applied by TheGreenBow VPN Client. 
 
 

4.3 How to protect a VPN Configuration before deployment? 
A VPN Configuration can be exported from TheGreenBow VPN Client, in order to be deployed to all employees in 
the company. 

� Select the menu "File > Export VPN Configuration". 

� Select "Protect the exported VPN Configuration" and enter a password, then click on "Ok". 
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The exported VPN Configuration is encrypted. When the user will open it, he will be automatically asked for the 
password. 
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5 VPN Automations 

5.1 How to create a batch/script that automatically opens or closes a tunnel? 
From software release 4.1 and older, your batch/script can use a simple command line as followed: 
vpnconf.exe /open=[TunnelName] 

vpnconf.exe /close=[TunnelName] 

 
Before software release 4.1, process as follows: 

� Create a VPN Configuration with "Open automatically when Client starts" selected for the relevant Phase 2 

(Advanced Phase2 dialog) 

� Export the VPN Configuration in a file (e.g. "MyTunnel.tgb") 

� Add to your script the following command line: vpnconf.exe /import=MyTunnel.tgb 

 
This script will start the VPN Client software with "MyTunnel" VPN Configuration, and will automatically open the 
tunnel. 
 

To close a tunnel, the command line is: vpnconf.exe /stop. 

This command line will quit the VPN Client while closing all the opened tunnels. 
 

5.2 How to Open/Close a tunnel via a command line? 
See section 5.1 au-dessus. 
 
 

5.3 How to automatically open a web page when the VPN tunnel opens? 

� Create a VPN Configuration 

�Open the Phase2 "Scripts" window, and set the url of the web page (internet or Corporate Intranet) in the 

field: "Launch this script when this tunnel opens" 

� Save the configuration and open the tunnel: the web page is automatically opened as soon as the tunnel is 

opened. 
 

5.4 How to open a tunnel with a double-clic on a desktop icon? 
It is possible to open a tunnel with a double-clic on a desktop icon. This icon has just to be associated with a VPN 
Configuration: 
 

� Create a VPN Configuration with "Open automatically when Client starts" selected for the relevant Phase 2 

(Advanced Phase2 dialog) 

� Export the VPN Configuration in a file (e.g. "MyTunnel.tgb"), and copy, move or shortcut this file on the 

desktop. 
 
A double-clic (open) on the desktop icon will run the VPN Client software with the VPN Configuration "MyTunnel", 
which will automatically open the tunnel. 
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5.5 How to configure a "Dial-up" tunnel? 
See section 5.4 au-dessus. 
 

5.6 What is the difference between "/import" and "/importonce"? 

The option "/import" enables to import a VPN Configuration and start the VPN Client software if it is not 

already running. 

The option "/importonce" enables to import a VPN Configuration without starting the VPN Client. 

Both options import and update a VPN Configuration when the VPN Client software is already running, without 
stopping it. 
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6 Reference Manual 

6.1 VPN Client Setup Extract option 
Since the release 4.10, the VPN Client Setup embeds a specific setup for Windows Vista, and the classic setup 
for the other Windows version. The "/extract" option enables to get from the setup either the Vista setup or the 
XP/2000 setup : 

6.1.1 /extract 

Syntaxe: /extract:[vista|xp] 

Usage: Enables to extract the Vista or not vista Setup from the main VPN Client Setup. 
Note: /extract without any option will extract the setup associated to the platform on which the setup is ran. 

Example: setup /extract:vista 

 

6.2 VPN Client Setup command line options 
A set of command line options are available to customize the VPN Client setup. 
 
Warning: all the options below must be used together with the option "-s" (silent mode). 
 
Note: Command-line options that require a parameter must be specified with no space between the option and its 
parameter. Quotation marks around an option's parameter are required only if the parameter contains spaces. 
 

6.2.1 -s 

Syntaxe: -s ("s" must be preceded by only 1 dash) 

Usage: Enables a silent installation (no dialog are displayed to the user during the installation) 

Example: setup –s 

 

6.2.2 --license 

Syntaxe: --license=[license_number] ("license" must be preceded by 2 dashes) 

Usage: Enables to configure the license number. The license number can be a set of 24 or 20 hexadecimal 
characters, depending of the software release. 

Example: setup –s --license=1234567890ABCDEF12345678 

 

6.2.3 --start 

Syntaxe: --start=[logon|boot|manual] ("start" must be preceded by 2 dashes) 

Usage: Enables to configure the start mode for the VPN Client: after the logon windows, during the boot, or 
manually. Default is [logon]. 

Example: setup –s –start=manual 

 

6.2.4 --hide 

Syntaxe: --hide=[yes|no] ("hide" must be preceded by 2 dashes) 

Usage: Enables configure the VPN Client software with an invisible Graphical User Interface. Default is [no]. 

Example: setup –s –hide=yes 
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6.2.5 --vpngui 

Syntaxe: --vpngui=[full|user|hidden] ("vpngui" must be preceded by 2 dashes) 

Usage: Enables to define the GUI appearance when the VPN Client software starts. 

"full": The Configuration Panel is displayed. Default.   

"user": The Connection Panel is displayed. 

"hidden": The Configuration Panel and Connection Panel cannot be displayed. Only the systray menu can be 

opened. Tunnels can be opened with the systray menu. 

Note: "--vpngui=hidden" is exactly the same as the option "--hide=yes". This option available in 

early software release can still be used (e.g. for compatiblity reasons). 

Example: setup –s –vpngui=hidden 
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6.2.6 --activmail 

Syntaxe: --activmail=[activation_email] ("activmail" must be preceded by 2 dashes) 

Usage: Enables to force the email used for activation confirmation. During the activation process, the edit box 
used for entering this email will be disabled 

Example: setup –s –activmail=salesgroup@company.com 

 

6.2.7 --menuitem 

Syntaxe: --menuitem=[0..15] ("menuitem" must be preceded by 2 dashes) 

Usage: Enables to configure the items of the systray menu. The value is a bitfield, where each bit defines a menu 
item: 1 (1st bit)=Quit, 2 (2nd bit)=Connections, 4 (3rd bit)=Console, 8 (4th bit)=Save&Apply 

Example: setup –s --menuitem=3 will only show the "Quit" and "Connections" menu items. 

 
Note 1: the tunnels are always shown in the systray menu, and can always be opened and closed from this 
systray menu. 
 

Note 2: "--menuitem" and "--vpngui=hidden" 

By default, "--vpngui=hidden" set the systray menu to Quit + Console. (The items Save & Apply and 

Connection Panel are not visible). But "--menuitem" overrides "--vpngui". That means the following 

options: "--vpngui=hidden --menuitem=1" will set a systray menu with only the "Quit" item. 

 

6.2.8 --password 

Syntaxe: --password=[password] ("password" must be preceded by 2 dashes) 

Usage: Enables to control the access to the VPN GUI with a password. 
The user will be asked for the password: 
- when the user clicks or double-clicks on the VPN systray icon. 
- when the user wants to switch from the Connection panel to the Configuration panel. 

Example: setup –s --vpngui=user --password=adm253q 

 

6.2.9 -f1 

Syntaxe: -f1[iss_FileName] ("f1" must be preceded by 1 dash) 

Usage: allows to specify an "InstallShield Setup" file, typically used with silent installation (See previous sections 
for various use cases). 

Example: setup –s –f1"C:\temp\setup.iss" 

 

6.2.10 -f2 

Syntaxe: -f2[log_FileName] ("f2" must be preceded by 1 dash) 

Usage: allows to specify a log file. When running a setup in silent mode be aware that no messages are 
displayed. Instead, a log file named setup.log captures setup information, including whether the setup was 
successful. By default the log file is created in the same folder as setup.exe. 
The f2 and f1 options must be used in conjunction. 

Example: setup –s –f1"C:\temp\setup.iss" –f2"c:\setup.log" 

 
The ResultCode value in the [ResponseResult] section of setup.log enables to verify if a silent installation 
succeeded. The log file looks as follows: 
 
[InstallShield Silent] 
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Version=v6.00.000 

File=Log File 

[ResponseResult] 

ResultCode=0 

[Application] 

Name=TheGreenBow VPN 

Version=2.50 

Company=SISTECH 

Lang=040c 

 
"ResultCode" gives a status about the installation process. Status may be the following: 
0 Success. 
-1 General error. 
-2 Invalid mode. 
-3 Required data not found in the Setup.iss file. 
-4 Not enough memory available. 
-5 File does not exist. 
-6 Cannot write to the response file. 
-7 Unable to write to the log file. 
-8 Invalid path to the InstallShield Silent response file. 
-9 Not a valid list type (string or number). 
-10 Data type is invalid. 
-11 Unknown error during setup. 
-12 Dialog boxes are out of order. 
-51 Cannot create the specified folder. 
-52 Cannot access the specified file or folder. 
-53 Invalid option selected 
 

6.3 VPN Client command line options 
TheGreenBow IPSec VPN Client enables to run command line options, used to open/close a tunnel, import a new 
VPN Configuration, etc... The syntax of a command line option is always the same: 
[install_directory]\vpnconf.exe [/option[=value]] 

where "install_directory" is the installation directory of the VPN Client software. 
 
A command line can be used in batch files, in scripts or in setup "inf" files as detailed in previous chapters. 
 
The available command line options are detailed below: 

6.3.1 /import 

Syntax: /import=[ConfigFileName] 

Usage: Enables the VPN Client to import a VPN Configuration. If the VPN Client software is not running, it is 
automatically started by this option. Thus, this option may be used to start the VPN Client with a given VPN 
Configuration. 
If the VPN Client software is running, this option imports and updates the VPN Configuration without stopping the 
software. 
[ConfigFileName] must be enclosed in double-quotes if it contains space characters. 

Example: vpnconf.exe /import="c:\my documents\myvpnconf.tgb" 

 
From software release 4.1 and older, the user is asked for adding or replacing the new VPN Configuration. To 
avoid this question, /import can be replaced by the options /add or /replace described below. 
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6.3.2 /importonce 

Syntax: /importonce=[ConfigFileName] 

Usage: Enables the VPN Client to import a VPN Configuration. If the VPN Client software is not running, it won't 
be started by this option. Thus, this option may be used to import a given VPN Configuration without starting the 
VPN Client, for example within an installation script. 
If the VPN Client software is running, this option imports and updates the VPN Configuration without stopping the 
software. 
 [ConfigFileName] must be enclosed in double-quotes if it contains space characters. 

Example: vpnconf.exe /importonce="c:\my documents\myvpnconf.tgb" 

 
From software release 4.1 and older, the user is asked for adding or replacing the new Configuration. To avoid 
this question, /importonce can be replaced by the options /add or /replace described au-dessous. 
 

6.3.3 /export 

Syntax: /export=[ConfigFileName] 

Usage: Enables the VPN Client to export a VPN Configuration. If the VPN Client software is not running, it is 
automatically started by this option. 
If the VPN Client software is running, this option exports the VPN Configuration without stopping the software. 
 [ConfigFileName] must be enclosed in double-quotes if it contains space characters. 

Example: vpnconf.exe /export="c:\my documents\myvpnconf.tgb" 

6.3.4 /exportonce 

Syntax: /exportonce=[ConfigFileName] 

Usage: Enables the VPN Client to export a VPN Configuration. If the VPN Client software is not running, it won't 
be started by this option. 
If the VPN Client software is running, this option exports the VPN Configuration without stopping the software. 
 [ConfigFileName] must be enclosed in double-quotes if it contains space characters. 

Example: vpnconf.exe /exportonce="c:\my documents\myvpnconf.tgb" 

6.3.5 /pwd 

Syntax: /pwd=[Password] 

Usage: Enables to set a password for import operations. This option must be used together with the /import or 
/importonce options. 

Example: vpnconf.exe /import="c:\my documents\myvpnconf.tgb" /pwd=mypwd 

6.3.6 /stop 

Syntax: /stop 

Usage: Enables to exit the VPN Client and close the opened VPN tunnels 

Example: vpnconf.exe /stop 

6.3.7 /add 

Syntax: /add=[ConfigFileName] 

Usage: Enables to add a VPN Configuration to the current configuration. This feature is available in software 
release  4.1 and older, and may be used instead of the /importonce option. 

Example: vpnconf.exe /add="c:\my documents\myvpnconf.tgb" 
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6.3.8 /replace 

Syntax: /replace=[ConfigFileName] 

Usage: Enables to replace the current configuration by a new VPN Configuration. This feature is available in 
software release  4.1 and older, and may be used instead of the /importonce option. 

Example: vpnconf.exe /replace="c:\my documents\myvpnconf.tgb" 

 

6.3.9 /open 

Syntax: /open=[TunnelName] 

Usage: Enables to open a VPN tunnel. 

Example: vpnconf.exe /open="Corporate" 

6.3.10 /close 

Syntax: /close=[TunnelName] 

Usage: Enables to close a VPN tunnel. 

Example: vpnconf.exe /close="Home" 

 
 

6.4 Customize an installation configuration file ("setup.iss") 
It is also possible to simply customized the installation configuration file ("setup.iss") from the sample below: copy 
the following lines in a file called "setup.iss" under the setup directory, and optionaly change the parameters to 
match your installation requirements: 
 
[InstallShield Silent] 

Version=v6.00.000 

File=Response File 

[File Transfer] 

OverwrittenReadOnly=NoToAll 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-DlgOrder] 

Dlg0={389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdWelcome-0 

Count=6 

Dlg1={389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdLicense-0 

Dlg2={389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdAskDestPath-0 

Dlg3={389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdSelectFolder-0 

Dlg4={389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-File Transfer 

Dlg5={389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdFinishReboot-0 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdWelcome-0] 

Result=1 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdLicense-0] 

Result=1 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdAskDestPath-0] 

szDir=C:\Program Files\TheGreenBow\TheGreenBow VPN 

Result=1 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdSelectFolder-0] 

szFolder=TheGreenBow VPN 

Result=1 

[Application] 

Name=TheGreenBow VPN Client 

Version=4.0 

Company=TheGreenBow 

Lang=040c 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-File Transfer] 

LockedFile=YesToAll 

[{389B10EB-C21E-4B3D-8052-F44DA38CDE4C}-SdFinishReboot-0] 

Result=1 

BootOption=0 
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7 Support 

For an in-depth look at the methods and options of the InstallShield Silent Install, refer to the following URL, at the 
InstallShield (www.installshield.com) web site. 

Information and update are available at: www.thegreenbow.com  

Technical support by email at: support@thegreenbow.com   

Sales at +33 1 43 12 39 37, or via email at: sales@thegreenbow.com  
 

 


